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1 INTRODUCTION 

1.1 CAUTIONS  
CAUTION 

The GPS system is operated by the government of the United States, which is solely responsible for its 
accuracy and maintenance. Although the GPS 10x is a precision electronic NAVigation AID (NAVAID), 
any NAVAID can be misused or misinterpreted, and therefore become unsafe. Use these products at your 
own risk. To reduce the risk, carefully review and understand all aspects of these Technical Specifications 
before using the GPS 10x. When in actual use, carefully compare indications from the GPS to all available 
navigation sources including the information from other NAVAIDs, visual sightings, charts, etc. For safety, 
always resolve any discrepancies before continuing navigation. 

FCC 
Compliance 

The GPS 10x complies with Part 15 of the FCC interference limits for Class B digital devices FOR HOME 
OR OFFICE USE. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation, and are more stringent than “outdoor” requirements. 

Operation of this device is subject to the following conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

The GPS 10x does not contain any user-serviceable parts. Unauthorized repairs or modifications could 
result in permanent damage to the equipment, and void your warranty and your authority to operate this 
device under Part 15 regulations. 

Battery Warnings 
If these guidelines are not followed, the lithium-ion battery may experience a shortened life span or may 
present a risk of damage to the GPS unit, fire, chemical burn, electrolyte leak, and or injury. Contact your 
local waste department to properly dispose of the unit/battery. 

• Do not leave the unit exposed to a heat source or in a high temperature location, such as in the sun 
in an unattended vehicle on a hot day. To prevent damage, remove the unit from the vehicle or 
store it out of direct sunlight, such as in the glove box. 

• Do not incinerate. 

• When storing the unit for a limited length of time, store within the following temperature range: -
4˚ to 140˚F (-20˚ to 60˚C). When storing the unit for an extended time, store within the following 
temperature range: 32˚ to 77˚F (0˚ to 25˚C). 

• Do not operate the unit outside of the following temperature range:  
14˚ to 140˚F (-10˚ to 60˚C). 

• Keep the used battery away from children. Do not disassemble, puncture, or damage the battery. 
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1.2 LIMITED WARRANTY 
This Garmin product is warranted to be free from defects in materials or workmanship for one year from 
the date of purchase. Within this period, Garmin will at its sole option repair or replace any components 
that fail in normal use. Such repairs or replacement will be made at no charge to the customer for parts or 
labor, provided that the customer shall be responsible for any transportation cost. This warranty does not 
cover failures due to abuse, misuse, accident, or unauthorized alteration or repairs. 

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY 
LIABILITY ARISING UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO STATE. 

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR 
INABILITY TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states do not 
allow the exclusion of incidental or consequential damages, so the above limitations may not apply to you. 

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the 
purchase price at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE 
REMEDY FOR ANY BREACH OF WARRANTY. 

To obtain warranty service, contact your local Garmin authorized dealer or call Garmin Product Support at 
one of the numbers listed below for shipping instructions and an RMA tracking number. The unit should be 
securely packed with the tracking number clearly written on the outside of the package. The unit should 
then be sent, freight charges prepaid, to any Garmin warranty service station. A copy of the original sales 
receipt is required as the proof of purchase for warranty repairs. 

Garmin International, Inc. 
1200 E 151st Street, Olathe, Kansas 66062 U.S.A. 
Tel. 913/397.8200 or 800/800.1020 
Fax. 913/397.8282 

Garmin (Europe) Ltd. 
Unit 5, The Quadrangle, Abbey Park Industrial Estate, Romsey, SO51 9DL U.K. 
Tel. 44/0870.8501241 (outside the UK) 0808 2380000 (inside the UK) 
Fax 44/0870.8501251  

Online Auction Purchases: Products sold through online auctions are not eligible for rebates or other 
special offers from Garmin. Online auction confirmations are not accepted for warranty verification. To 
obtain warranty service, an original or copy of the sales receipt from the original retailer is required. 
Garmin will not replace missing components from any package purchased through an online auction. 

International Purchases: A separate warranty is provided by international distributors for units purchased 
outside the United States. This warranty is provided by the local in-country distributor and this distributor 
provides local service for your unit. Distributor warranties are only valid in the area of intended 
distribution. Units purchased in the United States or Canada must be returned to the Garmin service center 
in the United Kingdom, the United States, Canada, or Taiwan for service.  
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1.3 OVERVIEW 
The GPS 10x product is a high sensitivity SiRFstarIIITM GPS receiver with WAAS capability, a removable 
rechargeable lithium-ion battery, and Bluetooth® wireless technology capability. The GPS 10x tracks up to 
12 satellites at a time while providing fast time-to-first-fix, one-second navigation updates, and low power 
consumption. This generation of GPS sensors adds the capability of FAA Wide Area Augmentation System 
(WAAS) differential GPS. The GPS 10x’s far-reaching capability meets the sensitivity requirements of 
land navigation as well as the dynamics requirements of high-performance aircraft. 

The GPS 10x design uses the latest technology and high-level circuit integration to achieve superior 
performance while minimizing space and power requirements. All critical components of the system 
including the GPS RF/IF receiver hardware and the GPS digital baseband are designed and manufactured 
by Garmin to ensure the quality and capability of the GPS. The hardware capability combined with 
software intelligence makes the GPS 10x easy to integrate and use for laptop/tablet PC, PDA, and smart 
phone applications by incorporating a Class 2 Bluetooth module within the unit. 

The GPS 10x product is designed to withstand rugged operating conditions. This complete GPS receiver 
requires no additional components to be supplied by an OEM or system integrator. A removable 
rechargeable lithium-ion battery and 12 VDC charging adapter are provided with the receiver. The only 
requirement is a clear view of the GPS satellites. Internal FLASH memory allows the GPS to retain critical 
data such as satellite orbital parameters, last-known position, date and time. End user interfaces such as 
keyboards and displays are the responsibility of the application designer. 

1.4 FEATURES 
• Integrated Bluetooth® (Class 2) wireless technology module for communication with a mobile 

device. 

• High sensitivity SiRFstarIIITM GPS receiver uses up to 12 satellites for fast, accurate positioning 
and low power consumption. 

• Differential DGPS capability using real-time WAAS corrections yielding position errors of less 
than 3 meters. 

• Compact, rugged design ideal for applications with minimal space. Receiver position information 
can be displayed directly on a chartplotter or laptop/tablet PC, PDA, or smart phone with 
Bluetooth wireless technology capability. 

• User initialization is not required. Once installed, unit automatically produces navigation data after 
position fix is acquired. 

• User-configurable navigation mode (2-dimensional or 3-dimensional fix). 

• Configurable for binary format carrier phase data output. 

• FLASH-based program and non-volatile memory. New software revisions available through Web 
site download. Non-volatile memory does not require battery backup. 

• Removable rechargeable main power battery.  

• The real-time clock can run for up to 2 months after the battery enters a low battery mode. 

• Configurable parameters include expected position, current time and date, preferred position fix 
type (2D, 3D, or automatic), and velocity filter time constant (none, automatic, or your choice 
between 2 and 255 seconds).  

• Four anti-skid mounts for flat surface placement. 

• Includes 12 VDC Cigarette Lighter Charging Adapter. 

• Auto Power On Mode: When in the Off mode and connected to a switched 12 V DC external 
power source, the GPS 10x automatically turns On when external power is turned on. (example: a 
cigarette lighter controlled by the vehicle ignition switch.) 



1.4.1 GPS 10x Wireless Receiver 
The GPS 10x uses Bluetooth® wireless technology to interface with a mobile device (Computer/PDA) that 
is Bluetooth wireless technology enabled.  

Class 2 Bluetooth device with power control capability based on the Bluetooth System Specification, 
Version 1.1. The supported profile is Serial Profile (SSP). 

Accessories provided with the GPS 10x:  

• 12 VDC Cigarette Lighter Charging Adapter with Mini B-USB Connector (010-10563-00) 

 
          DC Charging Adapter 

• Belt Clip (145-00956-70)  

• Optional 110-115 V AC Charging Adapter  with Mini B-USB connector (010-10723-00) 

 
                      Belt Clip                                              Optional Charging Adapter 

 
 

1.5 TECHNICAL SPECIFICATIONS 
Specifications are subject to change without notice. 

1.5.1 Physical Characteristics 
1.5.1.1 Size 

42 mm wide, 77 mm long and 18 mm in height (.697” H x 1.65”W x 3.04”D) 

1.5.1.2 Weight 
2.1  ounces (60 grams) 

1.5.1.3 Color 
Matt Metallic Silver with Black accents 

1.5.1.4 Case Material 
Polycarbonate thermoplastic and ABS case 
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1.5.2 Electrical Characteristics 
1.5.2.1 Input Voltage 

4.5–5.5 V 

1.5.2.2 Input Current  
500mA @ 5.0 V 

1.5.2.3 Battery  
• Capacity:   1100 mAHr 

• Charging rate:  Approx. 4 Hrs  

• Operating time:  Approx. 22 Hours with WAAS enabled. 

1.5.2.4 Battery Charger  
The included Cigarette Lighter Adapter (010-10563-00) can be used to charge the GPS 10x’s 
internal battery  

1.5.3 Environmental Characteristics 
1.5.3.1 Operating Temperature Range 

• -30°C to + 60°C   Powered from external supply 

• -10°C to +60°C    Powered by removable rechargeable battery 

1.5.3.2 Battery Charging Temperature Range 
5°C to 45°C   

• Input     10 to 30 V AC 

• Output  4.9 to 5.25 V DC @ 1.0 A  

1.5.3.3 Storage Temperature  
 -30°C to 60°C 

1.5.4 GPS Performance 
1.5.4.1 Receiver 

High sensitivity SiRFstarIIITM GPS receiver; WAAS-enabled. 

1.5.4.2 Acquisition Times  
(On average for a stationary receiver with a clear view of the sky.) 

• Warm: <1 sec 

• Cold: <38 sec 

• Factory Reset: <45 sec 

1.5.4.3 Update Rate  
1 record per second, continuous 
 

1.5.4.4 Accuracy 
• GPS accuracy 

Position: <10 meters, typical 
Velocity: 0.05 meters/sec RMS 
 

• GPS (WAAS) accuracy 
Position: <5 meters, typical 
Velocity: 0.05 meters/sec RMS  
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1.5.5 Interfaces 
1.5.5.1 GPS 10x Electrical Characteristics 

• Communicate with Host Platform via Bluetooth Serial Profile 

• Typical Range: up to 32 feet (10 meters) 

1.5.5.2 Garmin Interface  
Refer to the Garmin Device Interface Specification for specific information about the Garmin 
Protocol. The document is located on the Garmin Web site at http://www.garmin.com/support/ 
commProtocol.html. See also Appendix A: Binary Phase Output Format for additional information 
concerning access to raw pseudo-range and carrier phase data from the GPS 10x. 

1.5.5.3 GPS 10x Protocol 
• NMEA 0183 Version 2.0 or NMEA 0183 Version 2.30 (Version 2.0 is factory default, 

programmable by data field 1 of the PGRMC1 sentence described in Section 3.1.1 Additional 
Sensor Configuration Information (PGRMC1). To determine the specific sentences supported by 
SiRF, refer to the SiRF website. 

• Available NMEA 0183 output sentences include GPGGA, GPGSA, GPGSV, GPRMC, GPVTG, 
GPGLL, and PGRMT (Garmin proprietary sentences). See Section 3.2 Transmitted NMEA 0183 
Sentences for format descriptions. 

• Configuration and initialization is accomplished with NMEA 0183 input sentences. Allows 
initialization of information such as expected position, date, time, earth datum, and differential 
mode. See Section 3.1 Received NMEA 0183 Sentences for format descriptions. 

• Configurable for binary data output including GPS carrier phase data. 

http://www.garmin.com/support/commProtocol.html
http://www.garmin.com/support/commProtocol.html


2 MECHANICAL CHARACTERISTICS & MOUNTING  
Figure 1 shows the operational characteristics of the GPS 10x. Figure 2 shows the auxiliary power plug 
dimensions. Power Plug Specifications for charging the GPS 10x from user provided power source: Mini-
USB connector  (Range 4.5 to 5.5 VDC @ 500 mA)  

 

Figure 1. GPS 10x Operational Characteristics 
 
 

Bluetooth LED
Rapid Flashing Blue: Power On, Bluetooth On
Slow Flashing Blue: Bluetooth link established

Power Status LED
Flashing Yellow-Green: Charging in progress
Solid Yellow-Green: Battery charged
Flashing Orange: Low battery
Solid Orange: Faulty battery or system error

Power On.Off Button
Mini-USB Connector for Power Cable
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3 GPS 10X SOFTWARE INTERFACE 
The interface protocol design of the GPS 10x product is based on the National Marine Electronics 
Association’s NMEA 0183 ASCII interface specification. This standard is fully defined in NMEA 0183, 
Version 2.30. Copies may be obtained from NMEA, http://www.nmea.org/.  

In addition to the standard NMEA 0183 sentences, the GPS 10x may also be configured to transmit  
information over their serial interface using NMEA 0183 compliant Garmin proprietary sentences. These 
proprietary sentences begin with the characters, “$PGRM”, instead of the characters “$G” that are typical 
of the standard NMEA 0183 sentences. The characters “$P” indicate that the sentence is a proprietary 
implementation and the characters and “GRM” indicate that it is Garmin’s proprietary sentence. The letter 
(or letters) that follow the characters “$PGRM” uniquely identifies that particular Garmin proprietary 
sentence. 

It is also possible to configure the GPS 10x to transmit binary phase data information over their serial 
interface. See Appendix A: Binary Phase Output Format for details.  

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by 
the GPS 10x product.   

3.1 RECEIVED NMEA 0183 SENTENCES 
The following paragraphs define the sentences that can be received on the GPS sensor’s port. Null fields in 
the configuration sentence indicate no change in the particular configuration parameter. All sentences 
received by the GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return 
(0D hexadecimal) and line feed (0A hexadecimal). The checksum *hh is used for parity checking data and 
is not required, but is recommended for use in environments containing high electromagnetic noise. It is 
generally not required in normal PC environments. When used, the parity bytes (hh) are the ASCII 
representation of the exclusive-or (XOR) sum of all the characters between the “$” and “*” characters, non-
inclusive. The hex representation must be a capital letter, such as 3D instead of 3d. Sentences may be 
truncated by <CR><LF> after any data field and valid fields up to that point will be acted on by the sensor. 

3.1.1 Additional Sensor Configuration Information (PGRMC1) 
The $PGRMC1 sentence provides additional information used to configure the GPS sensor operation. 
Configuration parameters are stored in non-volatile memory and retained between power cycles. The GPS 
sensor will echo this sentence upon its receipt if no errors are detected. If an error is detected, the echoed 
PGRMC1 sentence will contain the current default values. Current default values can also be obtained by 
sending $PGRMC1E to the GPS sensor. 

$PGRMC1,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh<CR><LF> 

<11> Auto Power Off, 1 = Off, 2 = On 
<12> Power On with External Charger, 1 = Off, 2 = On 

 

Configuration changes take effect immediately, with the exception of Binary Phase Output Data, which 
takes effect on the next power cycle or a reset event. If the GPS sensor is in the Binary data mode, it is 
necessary to send the following eight-byte data stream to temporarily change the data format to NMEA 
0183. Then follow by sending a PGRMC1 sentence that turns off the Binary Phase Output Data format: 

10 0A 02 26 00 CE 10 03 (Hexadecimal) 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.nmea.org/
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3.1.2 Output Sentence Enable/Disable (PGRMO) 
The $PGRMO sentence provides the ability to enable and disable specific output sentences. The following 
sentences are enabled at the factory: GPGGA, GPGSA, GPGSV, GPRMC, and PGRMT. 

$PGRMO,<1>,<2>*hh<CR><LF> 

<1> Target sentence description (e.g., PGRMT, GPGSV, etc.) 
<2> Target sentence mode, where: 

 0 = disable specified sentence 
 1 = enable specified sentence 
 2 = disable all output sentences  
 3 = enable all output sentences (except GPALM) 
 4 = restore factory default output sentences 

The following notes apply to the PGRMO input sentence: 

1. If the target sentence mode is ‘2’ (disable all), ‘3’ (enable all), or ‘4’ (restore defaults), the target 
sentence description is not checked for validity. In this case, an empty field is allowed (e.g., 
$PGRMO,,3), or the mode field may contain from 1 to 5 characters. 

2. If the target sentence mode is ‘0’ (disable) or ‘1’ (enable), the target sentence description field must be 
an identifier for one of the sentences that can be output by the GPS sensor. 

3. If either the target sentence mode field or the target sentence description field is not valid, the PGRMO 
sentence will have no effect. 

4. $PGRMO,,G will cause the COM port to change to Garmin Data Transfer format for the duration of 
the power cycle. The Garmin mode is required for GPS 10 series product software updates. 

 

3.2 TRANSMITTED NMEA 0183 SENTENCES 
The subsequent paragraphs define the sentences that can be transmitted by the GPS 10x. 

3.2.1 Sentence Transmission Rate 
Sentences are transmitted with respect to the user selected baud rate. 

The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence 
descriptions) at a periodic rate based on the user selected baud rate and user selected output sentences. The 
GPS sensor will transmit the selected sentences contiguously. The length of the transmission can be 
determined by the following equation and Tables 2 and 3: 

     total characters to be transmitted 
 length of transmission     =            --------------------------------------------- 
     characters transmitted per second 

Sentence Output by Default? Maximum Characters 
GPGGA  82 
GPGSA  66 
GPGSV  70 
GPGLL  44 
GPVTG  42 
PGRMT Once per minute 50 

Table 1: NMEA 0183 Output Sentence Order and Size 

 
 
 
The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values 
in the table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. The 
factory set defaults will result in a once per second transmission at the NMEA 0183 specification. 
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3.2.2 Transmitted Time 
The GPS sensor outputs UTC (Coordinated Universal Time) date and time of day in the transmitted 
sentences. Before the initial position fix, the on-board clock provides the date and time of day. After the 
initial position fix, the date and time of day are calculated using GPS satellite information and are 
synchronized with the one-pulse-per-second output. 

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and 
correct the transmitted date and time of day. The transmitted date and time of day for leap second 
correction follow the guidelines in National Institute of Standards and Technology Special Publication 432 
(Revised 1990). This document is for sale by the Superintendent of Documents, U.S. Government Printing 
Office, Washington, D.C., 20402, U.S.A. 

When a positive leap second is required, one second is inserted at the beginning of the first hour (0h 0m 0s) 
of the day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The 
GPS sensor would have transmitted this information for the leap second added December 31, 1998 as 
follows: 

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69 

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67 

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67 

$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66 

If a negative leap second should be required, one second will be deleted at the end of some UTC month. 
The minute containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not 
transmit the time of day 0h 0m 0s (the “zero” second) for the day from which the leap second is removed. 

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69 

$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6A 

$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69 

3.2.3 Global Positioning System Fix Data (GGA) 
$GPGGA,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,M,<10>,M,<11>,<12>*hh<CR><LF> 

<1> UTC time of position fix, hhmmss format 
<2> Latitude, ddmm.mmmm format (leading zeros will be transmitted)  
<3> Latitude hemisphere, N or S 
<4> Longitude, dddmm.mmmm format (leading zeros will be transmitted)  
<5> Longitude hemisphere, E or W 
<6> GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available, 2 = 

Differential GPS (DGPS) fix available, 6 = Estimated 
<7> Number of satellites in use, 00 to 12 (leading zeros will be transmitted) 
<8> Horizontal dilution of precision, 0.5 to 99.9 
<9> Antenna height above/below mean sea level, -9999.9 to 99999.9 meters 

<10> Geoidal height, -999.9 to 9999.9 meters 
<11> Differential GPS (RTCM SC-104) data age, number of seconds since last valid RTCM 

transmission (null if not an RTCM DGPS fix) 
<12> Differential Reference Station ID, 0000 to 1023 (leading zeros will be transmitted, null if not an 

RTCM DGPS fix) 
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3.2.4 Recommended Minimum Specific GPS/TRANSIT Data (RMC) 
$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh<CR><LF> 

<1> UTC time of position fix, hhmmss format 
<2> Status, A = Valid position, V = NAV receiver warning 
<3> Latitude, ddmm.mmmm format (leading zeros will be transmitted)  
<4> Latitude hemisphere, N or S 
<5> Longitude, dddmm.mmmm format (leading zeros will be transmitted)  
<6> Longitude hemisphere, E or W 
<7> Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted) 
<8> Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted) 
<9> UTC date of position fix, ddmmyy format 

<10> Magnetic variation, 000.0 to 100.0 degrees (leading zeros will be transmitted) 
<11> Magnetic variation direction, E or W (westerly variation adds to true course) 
<12> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, 

D = Differential, E = Estimated, N = Data not valid 

3.2.5 Track Made Good and Ground Speed (VTG) 
$GPVTG,<1>,T,<2>,M,<3>,N,<4>,K,<5>*hh<CR><LF> 

<1> True course over ground, 000 to 359 degrees (leading zeros will be transmitted) 
<2> Magnetic course over ground, 000 to 359 degrees (leading zeros will be transmitted) 
<3> Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted) 
<4> Speed over ground, 0000.0 to 1051.8 kilometers per hour (leading zeros will be transmitted) 
<5> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, 

D = Differential, E = Estimated, N = Data not valid 

3.2.6 Geographic Position (GLL) 
$GPGLL,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF> 

<1> Latitude, ddmm.mmmm format (leading zeros will be transmitted)  
<2> Latitude hemisphere, N or S 
<3> Longitude, dddmm.mmmm format (leading zeros will be transmitted) 
<4> Longitude hemisphere, E or W 
<5> UTC time of position fix, hhmmss format 
<6> Status, A = Valid position, V = NAV receiver warning 
<7> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, 

D = Differential, E = Estimated, N = Data not valid 
 

3.2.7 GPS DOP and Active Satellites (GSA) 
$GPGSA,<1>,<2>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<4>,<5>,<6>*hh<CR><LF> 

<1> Mode, M = manual, A = automatic 
<2> Fix type, 1 = not available, 2 = 2D, 3 = 3D 
<3> PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be 

transmitted) 
<4> Position dilution of precision, 0.5 to 99.9 
<5> Horizontal dilution of precision, 0.5 to 99.9 
<6> Vertical dilution of precision, 0.5 to 99.9 
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3.2.8  

GPS Satellites in View (GSV) 
$GPGSV,<1>,<2>,<3>,<4>,<5>,<6>,<7>,...<4>,<5>,<6>,<7>*hh<CR><LF> 

<1> Total number of GSV sentences to be transmitted 
<2> Number of current GSV sentence 
<3> Total number of satellites in view, 00 to 12 (leading zeros will be transmitted) 
<4> Satellite PRN number, 01 to 32 (leading zeros will be transmitted) 
<5> Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted) 
<6> Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted) 
<7> Signal to noise ratio (C/No) 00 to 99 dB, null when not tracking (leading zeros will be 

transmitted) 
NOTE:  Items <4>,<5>,<6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites 
per sentence. Additional satellites in view information must be sent in subsequent bursts of NMEA 0183 
data. These fields will be null if unused. 

3.2.9 Sensor Status Information (PGRMT) 
The Garmin Proprietary sentence $PGRMT gives information concerning the status of the GPS sensor. 
This sentence is transmitted once per minute regardless of the selected baud rate. 

$PGRMT,<1>, , , , , , , , 

<1> Product, model and software version (variable length field, e.g., “GPS 10 SW VER  2.01 BT 
VER 1.27 764”) 
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APPENDIX A: BINARY PHASE OUTPUT FORMAT 
In binary phase output mode, GPS 10x series products will transmit two types of packets once per second.  
One record contains primarily post-process information such as position and velocity information.  The 
second record contains receiver measurement information.   

Refer to the Garmin Device Interface Specification for details on how to form and parse Garmin packets. 
At the time of this printing, these specs are available from the technical suppport section of our Web site at 
http://www.garmin.com/support/commProtocol.html. 

For the GPS 10, the two records must be enabled independently by commands to the unit. The ID of each 
command should be 10 decimal to signify that the record is a command.  The data portion of the packet 
should be one of the following: 

Function Command (base 10) 
Position Record On 49 
Position Record Off 50 

Receiver Measurement Record On 110 
Receiver Measurement Record Off 111 

 
Note that the satellite data information is also enabled when the position record is enabled.   

Records sent over RS232  begin with a delimiter byte (10 hex).  The second byte identifies the record type 
(33 hex for a position record and 72 hex for a satellite data record).  The third byte indicates the size of the 
data.  The fourth byte is the first byte of data.  The data is then followed by a checksum byte, a delimiter 
byte (10 hex), and an end-of-transmission character (03 hex).  Additionally, any DLEs (0x10) that appear 
between the delimeters are escaped with a second DLE.  There is sample code at the end of this section that 
will strip off the DLEs and ETXs. 

RS232 Packet: 

- 0x10    (DLE is first byte) 

- 0x##   (Record ID – single byte) 

- 0x##   (Number of data bytes – single byte) 

- data bytes  (See descriptions below) 

- 0x##   (2’s complement of the arithmetic sum of the bytes between the delimiters) 

- 0x10   (DLE) 

- 0x03   (ETX is last byte) 

USB packets contain only the record ID, size, and data payload. Refer to the Garmin Device Interface 
Specification for details on how to form and parse Garmin USB packets. The document is located on the 
Garmin Web site at http://www.garmin.com/support/ commProtocol.html.

USB Packet: 
- 0x##   (Record ID – single byte) 

- 0x##   (Number of data bytes – single byte) 

- data bytes  (See descriptions below) 
 
The data bytes of each packet contain the record specified by the record ID.  A description of each record 
follows.  
 
 
 
 
 
 
 
 
 
 
 

http://www.garmin.com/support/commProtocol.html
http://www.garmin.com/support/commProtocol.html
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Satellite Data Record 
The satellite data has a record ID of 0x72 with 84 (0x54) data bytes. The data bytes contain the data for the 
12 channels as described below. For each satellite, the following data is available: 

typedef struct 
 { 
 uint8 svid; //space vehicle identification (1-32 and 33-64 for WAAS) 
 uint16  snr;  //signal-to-noise ratio  
 uint8 elev; //satellite elevation in degrees 
 uint16 azmth; //satellite azimuth in degrees 
 uint8 status; //status bit-field  
 } cpo_sat_data; 
The status bit field represents a set of booleans described below: 

Bit Meaning when bit is one (1) 
0 The unit has ephemeris data for the specified satellite. 
1 The unit has a differential correction for the specified satellite. 
2 The unit is using this satellite in the solution. 

This pattern is repeated for all 12 channels for a total of 12 X 7 bytes = 84 (0x54) bytes : 

typedef struct 
 { 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 cpo_sat_data 
 } cpo_all_sat_data 
The RS-232 Packet for the Satellite Record looks like: 

- 0x10    (DLE is first byte) 
- 0x72   (Record ID – single byte) 
- 0x54   (Number of data bytes – single byte) 
- cpo_all_sat_data 
- 0x##   (2’s complement of the arithmetic sum of the bytes between the delimiters) 
- 0x10   (DLE) 
- 0x03   (ETX is last byte) 

 The USB Packet for the Satellite Record looks like: 

38 INDIAN - Thailand, Vietnam 
- 0x72   (Record ID – single byte) 
- 0x54   (Number of data bytes – single byte) 
- cpo_all_sat_data 
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Position Record 
The Position Record has a record identifier of  
typedef struct 
 { 
 float alt; 
 float epe; 
 float eph; 
Sample C code to receive the two records should filter DLE and ETX bytes as described below: 
typedef enum 
    { 
    DAT, 
    DLE, 
    ETX 
    } rx_state_type; 
 
/* Declare and initialize static variables */ 
static char in_que[ 256 ]; 
static int in_que_ptr = 0; 
static rx_state_type rx_state = DAT; 
 
. 
. 
.  
 float epv; 
 int fix; 
 double gps_tow; 
 double lat; 
 double lon; 
 float lon_vel; 
 float lat_vel; 
 float alt_vel; 
 float msl_hght; 
 int leap_sec; 
 long grmn_days; 
 } cpo_pvt_data; 
alt  Ellipsoid altitude (meters) 
epe  Est pos error (meters) 
eph  Pos err, horizontal (meters) 
epv  Pos err, vertical (meters) 
fix  0 = no fix; 1 = no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential; 6 + = undefined 
gps_tow  GPS time of week (sec) 
lat Latitude (radians)  
lon Longitude (radians)  
lon_vel Longitude velocity (meters/second) 
lat_vel Latitude velocity (meters/second) 
alt_vel Altitude velocity (meters/second) 
msl_hght Mean sea level height (meters) 
leap_sec UTC leap seconds 
grmn_days Garmin days (days since December 31, 1989) 
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DLE and ETX bytes: 
 
void add_to_que( char data ) 
{ 
#define DLE_BYTE 0x10 
#define ETX_BYTE 0x03 
 
if ( rx_state == DAT ) 
    { 
    if ( data == DLE_BYTE ) 
        { 
        rx_state = DLE; 
        } 
    else 
        { 
        in_que[ in_que_ptr++ ] = data; 
        } 
    } 
else if ( rx_state == DLE ) 
    { 
    if ( data == ETX_BYTE ) 
        { 
        rx_state = ETX; 
        } 
    else 
        { 
        rx_state = DAT; 
        in_que[ in_que_ptr++ ] = data; 
        } 
    } 
else if ( rx_state == ETX ) 
    { 
    if ( data == DLE_BYTE )  
        { 
        rx_state = DLE; 
        } 
    } 
if ( in_que_ptr > 255 ) 
    { 
    in_que_ptr = 0; 
    } 
} 
 

 

 

 

 

 

 

 

 

 

 

 

 



APPENDIX B: GPS 10X AND WINDOWS SERIAL MOUSE ISSUE 
Problem: It is possible for Windows to incorrectly interpret the NMEA 0183 output of the GPS 10x as the 
output of a Microsoft Serial BallPoint Mouse. When that happens, Windows loads drivers for the Serial 
BallPoint Mouse. This causes the cursor to move erratically about the display, clicking, right clicking, 
double clicking, dragging and dropping displayed items as it goes. On Windows 2000 and Windows XP, 
you may not experience the problem if you wait until after the computer is booted before connecting the 
GPS 10x to the serial communications port. This problem is not specific to the GPS 10x. Any NMEA 0183 
device connected to a Windows computer’s serial port is likely to cause this problem. Below are several 
possible solutions to this problem.  

Note: If you are using Garmin nRoute™ Navigation Software with your GPS 10x, you will not have this 
problem because the unit is programmed to produce data according to the binary format that is described in 
Appendix A: Binary Phase Output Format.  

If you wish to use a different navigation software application with your GPS 10x, you will need to de-select 
the “Phase Output Data” option that is discussed in Solution 3 below. 

Solution 1: The easiest solution is to disable the Serial BallPoint mouse in the Device Manager. Of course, 
this solution assumes that you do not need to use a Serial BallPoint mouse with your computer. When the 
wild mouse problem occurs follow the steps below.   

1. Unplug the DB9 connector. 

2. Right-click on the My Computer icon on your desktop and select Properties to open the Device 
Manager. 

3. Go to the hardware tab of the resulting pop-up window and click on the Device Manager button.   

4. Right-click on Serial BallPoint Mouse and choose the option to Disable (NOT uninstall) this device. 

Solution 2: Do not plug the DB9 connector into the computer until the computer is turned on and the 
operating system is completely booted up and running. Every time you use the GPS 10x, you will need to 
start the computer and operating system before making the connection between the GPS 10x PC and the 
computer. This solution usually works on Windows 2000 and Windows XP computers.   

Solution 3: Change the default output of the GPS 10x so that it does not automatically send NMEA 0183 
data to the computer (change the default configuration to enable “Phase Output Data”). Use the Garmin 
Sensor Configuration Software, named SNSRCFG.EXE, provided on the Web site to enable “Phase Output 
Data.” SNSRCFG.EXE is included with the latest GPS 10x firmware. 

Please note that by enabling “Phase Output Data,” the device will no longer appear as a NMEA 0183 
device to your computer. As a result, mapping applications that expect to hear NMEA 0183 data will not 
recognize your GPS 10x until you re-enable the NMEA 0183 output, disabling the “Phase Output Data” in 
the process. 

Refer to 

Appendix C: Sensor Configuration Software for complete information about downloading the Sensor 
Configuration Software application.  

After the Sensor Configuration Software is installed and running on your computer, follow the steps below 
to change the default data output of the GPS 10x.   

1. Select the GPS 10x from the list of sensors and click OK. The Sensor Configuration Software opens 
with the default configuration file for the GPS 10x, as shown on the next 
page.   

 

2. Select Config > Switch to NMEA Mode (or press the F10 key). 

3. Select Comm > Setup to open the Comm Setup Window. 
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4. Select the Serial Port to which the GPS 10x is connected. Select Auto to have the program 
automatically determine the Baud Rate, or select Manual to manually select the Baud Rate of the GPS 
10x. Click OK when done.   

Click the Connect icon , or select Comm > Connect to connect to 
the GPS 10x.   

5. Place a check mark in the box next to “Binary Output Data” to 
change the GPS 10x to Garmin Mode. The unit will keep this 
change in the programming until you change it again in the 
software.   

Note: Selecting Config > Switch to Garmin Mode (or pressing the F11 key) only changes the unit to 
work in Garmin Mode until power is cycled through the unit again. For a more permanent change, 
refer to step 8 above.    

6. Click OK when completed enabling “Binary Output Data.”   

7. You may disconnect and close the software when finished. The software configuration can also be 
saved for future reference.   

Refer to  

Appendix C: Sensor 
Configuration Software for 
complete information about 
downloading the Sensor 
Configuration Software 
application. 
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APPENDIX C: SENSOR CONFIGURATION SOFTWARE 
SNSRCFG configures the GPS sensors based on user-selected parameters. Some application features 
include the ability to download GPS sensor configuration, maintain different configurations in files, and 
perform GPS sensor configurations quickly with the use of one function key.   

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when 
using the software to configure your Garmin sensor.   

Downloading the Sensor Configuration Software 
The Garmin Sensor Configuration Software (SNSRCFG.exe) is available 
from the Garmin Web site. To download the software, start at 
http://www.garmin.com/oem, select the GPS 10x, and then select Software 
Updates. The Garmin Sensor Configuration Software (SNSRCFG.exe) is 
included in the software update download.   

Selecting a Model 
After opening the program (snsrcfg.exe), the following screen appears. Select the radio button next to the 
type of Garmin sensor you are configuring.   

Connecting to the Sensor 
After selecting the type of sensor, the following window opens. This is the Main Interface Screen for the 
program.  To configure your sensor, you must first connect to the sensor.   

 

1. Select Config > Switch to 
NMEA Mode (or press the 
F10 key). 

2. Select Comm > Setup to 
open the Comm Setup 
Window. 

3. Select the Serial Port to 
which the sensor is 
connected. Select Auto to 
have the program 
automatically determine the 
Baud Rate, or select 
Manual to manually select 
the Baud Rate of the GPS 
10x. Click OK when done.   

4. Click the Connect icon , 
or select Comm > 
Connect.   

5. To view the current 
programming of the sensor, 
select Config > Get 
Configuration from GPS 
(or press the F8 key). The 
current programming of the 
sensor is displayed in the 
window shown to the right.   
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File Menu 
The File Menu allows you to open, save, and print sensor configurations. The items in the File Menu work 
like most Windows-based programs. 

Comm Menu 
The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and 
disconnect from the sensor.   

 

Setup: Opens the Comm Setup Window, shown to the left. Select the Serial Port to which the sensor is 
connected from the drop-down list. Then select Auto (the program determines the baud rate on its own) or 
Manual (you then enter the baud rate) for the Baud Rate entry.   

Connect: Select Connect to connect to the sensor to change or view the 
configuration.  

Disconnect: Select Disconnect to disconnect from the sensor. 

Config Menu  
The Config (Configuration) Menu allows you configure the sensor as it is 
connected. 

NMEA Sentence Selections (F7): Displays the NMEA Sentence S 
elections Window. If the sentence is enabled, a check mark appears in the 
box to the left of the sentence name. Click the box to enable or disable to 
the sentence.  

Switch to NMEA Mode (F10): Switches the unit to NMEA Mode. The 
sensor must be in NMEA Mode when connected to this software.   

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode.  

View Menu 
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also 
customize how the program looks by showing and hiding the Toolbar and Status Bar.   

Help Menu 
The Help Menu displays the software version and copyright information.  
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APPENDIX D: HOST SYSTEM CONSIDERATIONS: 

PIN Code  
 
Some systems may or may not require a PIN Code in order to recognize the GPS 10x. 
The default PIN code for GPS 10x is “1234”. When you initially make this connection or the connection is 
terminated unexpectedly. 

 
 
Just type “1234” and click OK. 
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For the latest free software updates (excluding map data) throughout the life of your  
Garmin products, visit the Garmin Web site at www.garmin.com. 
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